
 

HyperWorks Desktop 

12.0.126 Release Notes 

Introduction 

HyperWorks Desktop12.0.126_hotfix contains bug fixes for HyperMesh and HyperForm. The details are 

documented below.  

Note:  HyperWorks Desktop12.0.126_hotfix is a cumulative release. It should be installed on top of 

HW12.0.110 and includes HyperWorks Desktop12.0.125_hotfix. 

 

HyperMesh  

Resolved Issue 

 Hmmenu.set file was not reloading the settings when you close and reopen a session 

 

HyperForm  

Resolved Issue 

 Discontinuous mesh created along the edges during hole filling operation. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

HyperWorks Desktop 

12.0.125 Release Notes 

Introduction 

HyperWorks Desktop12.0.125_hotfix contains enhancements and bug fixes for HyperMesh and 

HyperGraph. The details are documented below.  

Note:  HyperWorks Desktop12.0.125_hotfix is a cumulative release. It should be installed on top of 

HW12.0.110 and includes HyperWorks Desktop12.0.124_hotfix. 

 

HyperMesh  

New Features and Enhancements 

CAD 

 CATIA v5-6R2015 (R25) 

 PTC Creo 2.0 M140 and 3.0 M030 

 SolidWorks 2015 on Windows and Linux (2014 on MAC) 

o There is a known third-party library issue where reading certain SolidWorks 2015 files 

may crash the application.  Please exhibit caution and save your work before reading 

any SolidWorks 2015 files. 

 

Resolved Issues 

 Crashes related to binary file save  

 Disabled model checker auto-run  

 Application error associated with quick window selection 

 

Abaqus Interface 

Resolved Issue 

 Incorrect material/property assignment upon import if solver file has mixed HM comments and 

no HM comments 

 

HyperGraph 

Resolved Issue 

 Resolved plot window issue on machines with integrated graphics cards 

 

 



 

HyperWorks Desktop 

12.0.124 Release Notes 
 

Introduction 

HyperWorks Desktop12.0.124_hotfix contains enhancements and bug fixes for HyperMesh, HyperView,  

MediaView and Model Identification Tool. The details are documented below.  

Note:  HyperWorks Desktop12.0.124_hotfix is a cumulative release. It should be installed on top of 

HW 12.0.110 and includes HyperWorks Desktop12.0.123_hotfix. 

 

HyperMesh  

New Features and Enhancements 

CAD 

        Support of NX 10.0 (native reader) 

Resolved Issues 

General 

 Resolved an application error related to an Include export from Include browser view 

Connectors 

 The absorption of hexa adhesive seam and area connectors works reliable in combination with 

the “consider single element cluster” option now. 

 The feature angle is not updated to 46 after certain solid absorptions anymore. 

 The seam and area hexa adhesives realization types for Nastran and OptiStruct have been 

updated in a way that no RBE2 elements are created anymore, if the projection point is 

equivalent to a link mesh node. Also in these cases RBE3 elements are created. 

 

HyperView 

Resolved Issue 

Unexpected hang of HV when model file or h3d contains assembly information with circular referencing 

(e.g. Assembly 1 is both parent and child of Assembly2).  

LS-Dyna Interface  

Resolved Issue 

 Include files with long names are now written out in Master file during export.  

 

 



 

Nastran Interface 

Resolved Issue 

 Include files with long names are now written out in Master file during export. 

 

 

Abaqus Interface 

Resolved Issue 

 For Nastran to Abaqus converstion, if PbeamL, Pbeam, Pbar or Pbarl has a hyperbeam section 

assigned, during conversion the relation is lost. The relation maintained during conversion. 

 Duplicate property in different include leads to component property lose during import. This has 

been fixed. 

 Performance of Nastran to Abaqus conversion has been improved. 

 

MediaView  

Resolved Issue 

 If a video contains negative time values the correct time is now displayed in the Animation 

Control Panel and not Undeformed or Undefined. 

 

Model Identification Tool  

Resolved Issue 

 The algorithm we use to derive the cubic polynomial from the static stiffness data can cause 

parts of the cubic to have negative stiffness. Now we warn the user while loading the test data 

in to MIT tool. 

 Parameters in different order in GBS and OPT files. Fixed the input gbs and opt files by changing 

their order consistent with output GBS file. 

 

 

 

 

 



 

HyperWorks Desktop 

12.0.123 Release Notes 

Introduction 

HyperWorks HW12.0.123-HWDesktop contains fix for MotionView and HyperView. The details are 

documented below.  

Note:  HW12.0.123-HWDesktop is a cumulative release. It should be installed on top of HW 12.0.110, 

and it includes HW12.0.121-HWDesktop. 

 

MotionView 

 

Resolved Issue 

 Opening a model containing PointMass Body causes MotionView 12.0.121 to crash. This issue is 

fixed. 

 

HyperView 

 
 

LSDYNA interface 

 FEMZIP reader for Windows 64-bit and Linux 64-bit is upgraded to FEMZIP 8.08 libraries

 

 

 

 

 

 

 



 

HyperWorks Desktop 

12.0.121 Release Notes 
 

Introduction 

HyperWorks HW12.0.121-HWDesktop contains enhancements and bug fixes for HyperMesh, 

HyperView, HyperGraph, TextView, Model Identification Tool and MotionView. The details are 

documented below.  

Note:  HW12.0.121-HWDesktop is a cumulative release. It should be installed on top of HW 12.0.110, 

and it includes HW12.0.119-HWDesktop. 

 

HyperMesh  

 

New Features and Enhancements 

CAD 

 Support of CATIA V5-6R2014 (R24) 

 Support of ProE CREO 2 M120 

 Support of SolidWorks 2014 

 

Resolved Issues 

General 

 Resolved a crash related to turning off and on system id in numbers panel 

 Resolved crashes associated with invoking application using –nomenuset option 

 Application crash related to organize and reject in specific model setup  

 Filter option issue in model browser while working with id ranges 

 Creation of linear interpolation using temperature loads 

 

CAD 

 Fixed a model specific JT import issue  

 

Connectors 

 Export performance issue for models with large number of connector comments 

 

 

HyperView 

 

Resolved Issue 

 H3D contained all time steps even though it was exported with reduced time steps/higher frame 

rate. 

 



 

HyperGraph 

 

Resolved Issue 

 Reading curve data from *.dat ASCII files failed when the first value in line one of the first 

column was negative, the value was displayed in the component list of the build plots panel. 

This issue is fixed. 

 Plots could be now updated without saving and reopen a session file when the result files 

updated by the solver from a running simulation by clicking Apply in the define curves panel. 

This will not only redraw the curves but also redraw the labels when they contain Templex 

expressions which refer to this type, requests or components of this result file. 

 

TextView 

 

Resolved Issue 

 TextView now evaluates all Templex expressions when the ABC (Evaluation Mode Control Icon) 

is used. Before this was only possible by using the refresh button. 

 

MotionView 

 

Resolved Issues 

 Graphics Rotation angle can now be controlled in Tools -> Options -> Visualization 

 Issue of zero value precision in exporting polybeam property values has been resolved 

 Ctrl+E shortcut can now be used to invoke the Export Solver Deck dialog 

 Issue of status bar not indicating Export to Adams process has been fixed 

 CG Inertia summary reported erroneous moment of inertia values for bodies using a different 

IM Cordinate system. This issue has been resolved 

 MotionView missed errors on check model related to missing IM Origin point reference for body. 

This issue has been fixed 

 Warning message related to values with more than 77 characters during export to Adams has 

been removed 

 Some erroneous listing of systems and analyses in "BeginFlatListFastGet" and 

"BeginChildFastGet" TCL commands has been fixed 

 Graphic of type TUBE on Polybeam caused MotionView to crash in certain cases. This issue has 

been fixed 

 

Abaqus Interface 

New Features and Enhancements 

 Writing a log file for NASTRAN to Abaqus conversion 

Resolved Issues 

 ABAQUS Material Erastic Type=Traction export issue 

 

Following Nastran to Abaqus Conversion issues are resolved: 

 The entities CBUSH1D and PBUSH1D in Nastran are now supported for conversion 



 

 Added support of Mass element “CONM2” conversion  

 Selection option to customize the entity selection in the conversion tool 

 Conversion issues related entity names with quotes and special characters 

 Property id was not maintained when convert from NASTRAN to Abaqus and later do a 

conversion from Abaqus to NASTRAN 

 

Ansys Interface 

Resolved Issues 

 LSWRITE keyword is written out in the exported files for models without any loadsteps 

 Export of equations in the loadstep 

 

Nastran Interface 

Resolved Issues 

 Deletion of PFAST property using default HM Comment import method 

 

Model Identification Tool 

New Enhancement 

This new feature is for supporting frequency, and amplitude dependent bushings. The implementation 

consists of four different components that work together. Collectively, they provide a comprehensive 

capability for identifying bushings from test data and, subsequently, using bushing models in a 

simulation. The components are summarized below: 

 

Model Identification Tool 

The MIT manages the workflow associated with fitting experimentally-measured bushing data to 

analytical bushing models and storing these in ASCII property files. The models in this context are for 

frequency, amplitude and preload dependent bushings. Two dynamic and three static models are 

supported. The MIT is launched from HyperGraph. 

 

MIT Fitting Tool 

This tool is invoked by the MIT user interface. It applies sophisticated numerical methods to calculate 

model coefficients so that deviations between model behavior and known experimental data are 

minimized. The fitting tool is an extension to HyperGraph. 

 

Bushing Model in MotionView 

This is a set of panels in MotionView to instantiate and modify frequency, amplitude and preload 

dependent bushings in a vehicle model 

Altair Bushing Simulation Model 

The Altair Bushing Simulation Model is used with fitted bushing models in a multibody simulation. It is 

a solver run-time demand load library (.dll or shared library) that works with MotionSolve. Adaptors for 

Adams/Solver™, MATLAB™ and SIMPACK™ are also available.  

 



 

 The user interaction with this system is as follows: 

 The user interacts with the MIT to fit bushing test data to analytical models. The output of 

the fitting process is a GBS file that contains the coefficients for the analytical models. The 

GBS is thus an analytical representation of the test data. 

 A full vehicle model is built in MotionView. Bushings are used as flexible connectors at 

various places in the vehicle.  

 The model is passed to MotionSolve, the MBD solver. At run time, MotionSolve loads the 

Busing Simulation Model dll (or shared library) to evaluate bushing behavior. 

 The output from the solver is a set of files that describe the complete response of the 

vehicle for the test that was performed 



 

HyperWorks Desktop 

12.0.119 Release Notes 
 

Introduction 

HyperWorks HW12.0.119-HWDesktop contains some bug fixes for HyperCrash. The details are 

documented below.  

Note:  HW12.0.119-HWDesktop is a cumulative release. It should be installed on top of HW 12.0.110, 

and it includes HW12.0.118-HWDesktop. 

 

HyperCrash 

Resolved Issues 

 Organizing entities into includes could lead to a crash with the automatic generation of lock 

toggled ON 

 Creating multiple bolts was not possible if the model contained include files 

 Updating mass elements in the Added Mass panel was setting the value to 0 instead of using 

the one specified in the GUI.  

 In the connection panel, Adding multiple object to time history only added the first object in 

the list instead of all selected objects  

 

  



 

HyperWorks Desktop 

12.0.118 Release Notes 
 

Introduction 

HyperWorks HW12.0.118-HWDesktop contains enhancements and bug fixes for HyperMesh, 

HyperView, HyperGraph, HyperCrash and MotionView. The details are documented below.  

Note:  HW12.0.118-HWDesktop is a cumulative release. It should be installed on top of HW 12.0.110, 

and it includes HW12.0.117-HWDesktop. 

 

HyperMesh  

 

New Features and Enhancements 

Assembly 

 Teamcenter Item “Discipline” value can now be considered when determining batch meshing 

criteria and parameter files. 

 

CAD 

 Updated JT import to version 10.1 

 Updated native-Parasolid import to version 26 

 

Connectors 

 Seam adhesives support is added for Abaqus solver interface  

 

Resolved Issues 

Assembly 

 Resolved the issue where saving monolithic file fails if the module display name contains spaces 

or other special characters. 

 

Connectors 

 Application crash related to spot connector realization with imprints 

 

General 

 Resolved organization issue where systems without System Collector HM Comments across 

different includes were sometimes organized into existing System Collectors from different 

include files. 

 Vectors exported do not remain in the same collector of an include file on import 

 Loads and Systems are now organized along with Parent collector like elements and nodes. 

The support will be available from include view browser as well as from the organize panel. 

 Application crash related to loadstep selection with model that contains large number of 

loadsteps 



 

 RBE3 handling while using Box Trim 

 Application crashes while using “Display none” and “Display all” icons in the model browser 

after loading a nested include file using “import as include” option 

 Resolved a crash when performing a quality index node optimize operation on a free node 
 

CAD 

 Resolved a few model-specific CATIA import issues 

 

HyperView 

 

New Features and Enhancements 

 

Abaqus 6.14-1 ODB support 

 The Abaqus 6.14 -1 reader has been added for Windows 32/64bit and Linux 64bit. This release 

will continue to support previous release versions like 6.10, 6.10-EF, 6.11. 

 

Resolved Issue 

 

correctly remembered between sessions until the settings file is cleared. By default the angle is 

set to 15 degrees. 

 

HyperGraph 

 

Resolved Issues 

 Selecting in the Build Plots panel requests/components in the data list of the expanded 

requests/components list dialog no longer triggers an error message 

 Copying of whole data columns out of the Coordinate Info panel to export curve data e.g. into 

Excel via cut & paste is fixed. 
 

MotionView 

 

New Features and Enhancements 

 MotionView now provides an option to check model immediately upon opening it. Use “Check 

Model on opening” checkbox under Tools -> Options -> Check Model to check models for 

warning or errors upon opening a model. 

 

Resolved Issues 

 MotionView would lose the last setting of compliance option for joints. This issue has been fixed 

 Defining an attachment for a system using Bushing or BushingPair resulted in a misleading 

error, that such an option was not valid. This issue has been rectified. 

 Ctrl + E shortcut for exporting solver deck was not working. This issue has been fixed. 

 CG Inertia Summary reported wrong values of Mass moment of Inertia for flexible bodies when 

a Body Coordinate System is explicitly specified. This issue has been fixed. 

 The feature of controlling rotation angle of the graphic area is now available via Tools -> 

Options -> Visualization 



 

 

OptiStruct Interface 

 

Resolved Issues 

 Fixed an issue where duplicate loads imported with FE-Overwrite option were not importing 

correctly for some models. 

 Fixed a crash in Model Checker when applying Autocorrect to the Free RBE3 Elements check 

for some models. 

 

Nastran Interface 

Resolved Issues 

 HyperView not plotting acceleration results for some Nastran 2012 OP2 files issue has been 

corrected. 

 Fixed an issue where models with large number of BCTSET cards were failing to import into 

HyperMesh. 

 Fixed an issue where duplicate loads imported with FE-Overwrite option were not importing 

correctly for some models. 

 Fixed a crash in Model Checker when applying Autocorrect to the Free RBE3 Elements check 

for some models. 

 

Abaqus Interface 

New Features and Enhancements 

 

 Abaqus 6.14-1 ODB support 

The Abaqus 6.14 -1 reader has been added for Windows 32/64bit and Linux 64bit. This 

release will continue to support previous release versions like 6.10, 6.10-EF, 6.11. 

 

 HM Comments for Properties and Material 

 HM comments are added for Properties and Material.Components have always 

maintained their ID’s during Export and import. Both direct and indirect property 

assignment will be supported in the new HMcomment changes 

 HMComments are added for unassigned property and material. This allows 

maintaining the ID during export and import. 

 The name for Element Properties, Friction and physical constant is renamed during 

export and import. Since we have added HMcomments, during import the entity 

names are retained. 

 The properties and Material ID will be retained during import for “By HMComments” 

option alone. 

 New HyperMesh comment like **HMNAME PROPERTY is added to the following 

properties:  

 SURFACE SMOOTHING 

 SURFACE PROPERTY 

 ELEMENT PROPERTIES 

 JOINT 

 



 

 Limitation 

 The legacy files will not have ID during the first time import. Once you export a file 

from HM with the fix, then ID will be maintained during next import. 

 By default the Friction is not exported. It has to be assigned to Connector Friction.  

 If the user hand edits the HMcomments, and if the changes leads removing the 

comments for property or material than Id maintaining won’t be assure. This is not 

Abaqus Interface limitation, its applicable for other interface also. 

 The below keywords must have “define layer” toggle on to export. Otherwise it will 

not be written into to the input deck. 

 

 Rigid Display element 

 New element type “RDE – Rigid Display elements” is added for rigid and rbe3. This is 

only for display purpose in Hypermesh. It cannot be exported into an input deck.  

Resolved Issues 

Following Nastran to Abaqus Conversion issues are resolved: 

 

 New option “Convert Rigid Element to Hinge” is added which will convert rigid element with 

any one DOF 4, 5 or 6 is free to CONN3D2 with *Connecter section and type Hinge. This 

conversion only happens if the new option is toggle ON in Conversion Options GUI. 

 Nastran Non structural Mass in properties will be converted *Non Structural Mass in Abaqus 

 The MAT1 GE value will be added as a *DAMPING in *MATERIAL 

 The entities PBUSHT in Nastran is supported for conversion 

 

Ls-Dyna Interface 

 

Enhancements 

 Support optional line for *MAT_SIMPLIFIED_RUBBER/FOAM 

Resolved Issues 

 Resolved an issue that occurred when changing the path of an *INCLUDE_TRANSFORM 

(transformation manager frozen and transformation was not de-applied at export) 

 Some nodes belonging to *CONSTRAINED_SHELL_TO_SOLID were not exported correctly 

 Set containing solid elements were not resolved at import 

 

PamCrash Interface 

Resolved Issues 

 The direction of the concentrated load (CONLO) could be changed during import. This is 

corrected now.  

 

 

 



 

RADIOSS Interface 

 

Enhancements 

 Support for /PROP/TYPE18 (integrated beam) as per Radioss 12.0.210 
 

HyperCrash 

New Features and Enhancements 

 

General 

 Enhanced lock functionality 

 Lock type can be changed by browser icon  

 Make current and lock other options creates a full type of lock 

 Part of connection can now be selected in the graphics (can be added to sets or other entities) 

 Warning message displays in the Model Checker if entities referenced and the keyword are not 

in the same include 

 In the Model Checker, added the option to automatically move the elements to the include file 

in which the part they belong to is located 

 The replace report will be shown after HC<-> HM operation 

 

RADIOSS Profile 

 Group of subset can now be created on the fly from any entity (contacts, initial velocity) 

 Function of monitored volume can now be encrypted 

 All time history variable for monitored volume can now be selected from the browser 

 The model checker will report a warning if an empty set or surfaces is found 

 he model checker will report a warning if an unresolved ID is found in a time history (/TH) 

 Updated interface type 7 and 19 definition according to Radioss 12.0.210 

 Support of EREF 

 Support other legal values for venting start time (ITTF) in /MONVOL 

 

LS-Dyna Profile 

 2 new profile available: 

 971 R4: support of LS-DYNA keywords up to version R4 

 971 R6: support of LS-DYNA keywords up to version R6.1. In this profile it is possible to export an 

input deck from version R6.1 to R4. 

 The following materials were updated to version R4, R5 and R6.1: 

  MAT_006   MAT_103   MAT_160 (New!)

  MAT_015   MAT_116   MAT_169

  MAT_019   MAT_120   MAT_172

  MAT_036   MAT_123   MAT_181

  MAT_037   MAT_124   MAT_188

  MAT_041-050   MAT_125   MAT_191

  MAT_057   MAT_133   MAT_202 (New!)



 

  MAT_071   MAT_135 (New!)   MAT_224

  MAT_077   MAT_136   MAT_240

  MAT_089   MAT_151   

  MAT_100   MAT_154   

 

 The following keywords were updated to version R6.1: 

 *CONSTRAINED_JOINT_STIFFNESS 

 *HOURGLASS 

 *DEFORMABLE_TO_RIGID and *DEFORMABLE_TO_RIGID_AUTOMATIC 

 *CONTROL_SHELL 

 *MAT_ADD_EROSION 

 Optional cards in *CONTACT 

 *AIRBAG_PARTICLE 

 Newly supported keywords: 

 *DEFINE_CONNECTION_PROPERTIES 

 *INITIAL_VELOCITY_GENERATION_START_TIME 

 *MAT_ADD_THERMAL_EXPENSION 

 *DATABASE_CPM_SENSOR 

 *CONTROL_MPP_DECOMPOSITION_PARTSET_DISTRIBUTE 

 Enhanced replaced part by pairing table 

 Allow incoming parts to move to blank spaces. Drag and drop of multiple parts is now 

possible. 
 New preview table for material and sections prior to the replace operation 

 

 Enhanced GUI for LS-DYNA include import 

 Enhanced replace capabilities: 

 Unused part set are now updated during replace operation 
 Unused element set are now updated during replace operation 
 Treatment of unresolved ID in replace operation 

 All metadata can now be written in the XML block at the end of the input deck. An option is 

provided in the GUI to not export the M00 file. 

 Ability to merge and organize element without *PART card, at import, if their part ID already 

exists in the model 

 Ability to compare the materials (and related curves, tables) used in the model to the ones 

existing in a database. A warning is printed in the model checker if some differences are 

found. 

 llow to export only the content of the master file from the browser an the include setting 

panel

 

Result Mapper 

 Mapping of pressure load, temperature, force for OptiStruct 

 Mapping of fiber directions from material law58 on a material law25 

 

Resolved Issues 

 Part of connections were listed in the replace part by pairing table 

 If multiple parts were sent through HC<-> HM the elements/part definition was not 

maintained 



 

 Duplicate *INITIAL_VOLUME_FRACTION_GEOMETRY cards were created at import/export if 

the number of container was greater than 1 

 *ELEMENT_MASS was not handled correctly in part replace 

 Formula group (SET_TYPE_ADD ; *SET_TYPE_GENERAL) were not handled correctly in the 

replaced correctly in part replace 

 Corrected several issue in the implementation of *CONSTRAINED_INTERPOLATION 

 Corrected several issue in the preview of initial geometry 

(*INITIAL_FOAM_REFERENCE_GEOMETRY ; *AIRBAG_REFERENCE_GEOMETRY) 

 he display of the reference geometry was not correct if it was implicated in an 

*INCLUDE_TRANSFORM 

 *HOURGLASS ID in *PART is now maintained after part split operation 

 Fixed a crash that occurred when trying to delete several /MONVOL from the Monitored 

Volume panel 

 Duplicated tied contacts were created during part replacement 

 Initial stress data are now exported with the export selection function 

 Dummy positioning: 

 Incorrect stop angle was written in /DUMMY (12.0.113 & 12.0.115) which significantly 

reduced the range of motion for some joints 

 Current angle was reset to 0 after closing the Dummy Positioning panel for some joints 

 Reading of positioning file failed if the dummy title or joint name were too long 

 Reading of positioning file failed if the joint angle was at the stop angle 

 

 

 Moving parts to an include file that is locked is not possible anymore 

 The master surface of the symmetric interface type7 was not created correctly 

 *DEFINE_TRANSFORM was not outputted before *INCLUDE_TRANSFORM when it was defined 

in an include file 

 Replace operation was allowed on locked parts or parts with locked entities 

 Offset in *INCLUDE_TRANSFORM was not applied/disapplied correctly for some entities 

(*DEFINE_COORDINATE_SYSTEM; *DEFINE_COORDINATE_NODES) 

 Resolved several potential crashes when the section type /SECT/PARAL was used in the model 

 The rigid body master node was automatically reset to the center of gravity even when the 

“automatic master node” flag was checked off. 

 Result mapper: 

 If the stress check box was not selected the exported format of /INISHE cards was 

incorrect 

 Corrected a crash that occurred when attempting to contour mapped results without 

target model 

 Display of initial direction of orthotropy was incorrect   



 

HyperWorks Desktop 

12.0.117 Release Notes 
 

Introduction 

HyperWorks HW12.0.117-HWDesktop contains enhancements and bug fixes for HyperMesh, 

HyperView, HyperGraph and HyperForm. The details are documented below.  

Note:  HW12.0.117-HWDesktop is a cumulative release. It should be installed on top of HW 12.0.110, 

and it includes HW12.0.115-HWDesktop. 

 

HyperMesh  

 

New Features and Enhancements 

 
Assembly 

 Fixed the cadassm utility to properly write using UDM 12.0 format and to correct an issue where 

the part transformation matrix was not properly defined. 

 

General 

 Performance improvements for CFD load mapping for multiple time points 

 

Resolved Issues 

 

General 

 Default writing of hmsettings.tcl file to a mapped network drive with write permissions 

 HyperMesh panel height set using an API does not maintain after changing a user profile  

 Crash while accessing organize sets panel from tools pulldown. The error occurred in 12.115 

only while using old settings file from previous releases  

 

CAD 

 Incorrect offset with CATIA cone surfaces 

 Several specific CATIA import issues are fixed  

 

Graphics 

 Selection of new center of rotation was, in some cases, not being correctly defined and would 

cause the model to rotate in an undesired manner.  

 

Meshing 

 Automesh panel incorrectly detects small unmeshed surfaces 

 

 

 



 

HyperView 

 

Resolved Issues 

 Crash issue when creating a measure using Node Path 

 Ensight reader is flipping the connectivity of second order elements  

 

HyperGraph 

 

Resolved Issues 

 Performance issue related to reading of large Abaqus ODB files 

 Difference in results while using Rainflow function 

 Unable to change the Min & Max of the horizontal scale from the axis panel. 

 
 

OptiStruct Interface 

 

Resolved Issues 

 Issue related to reading of HMDPRP IDs that are listed in the same line of HMDPRP comment. 

 Summary template for Moment of Inertia showing sign mismatch for off-diagonal inertia values 

between using Center of Gravity or Origin as center. 

Nastran Interface 

 

Resolved Issues 

 Conversion issue related to DOF mapping from SPRING1 element type of Abaqus to CELAS1 

element type in NASTRAN  

 Issues related to RBE3 handling are resolved for Box Trim Utility 

 Issue related to reading of HMDPRP IDs that are listed in the same line of HMDPRP comment. 

 Summary template for Moment of Inertia showing sign mismatch for off-diagonal inertia values 

between using Center of Gravity or Origin as center. 

Abaqus Interface 

New Features and Enhancements 

 

 8 New bolt type configuration are added for the 1D>Connectors>bolt option. This includes 

Bolt(Spider), Bolt (washer), Bolt (washer 1 alt), Bolt (washer 1 B31), Bolt (washer 2),         

Bolt (washer 2 alt), Bolt (step hole) and Bolt (threaded step hole) 

 

Resolved issue: 

 Moment of inertia calculation from Post>summary panel has been updated to include Rotary 

Inertia element with *orientation defined. The orientation for these elements type can be 

defined from Rotary inertia Property    

 

 

 



 

Ls-Dyna Interface 

New Features and Enhancements 

 

 Vector support is added to *BOUNDARY_PRESCRIBED_MOTION_NODE keyword  

 DOF -4 is now supported as acceptable value in *BOUNDARY_PRESCRIBED_MOTION_NODE 

keyword 

 Binout reader updated to read binout files with outputs from *DEFINE_CPM_CHAMBER 

 

Resolved Issues 

 Unnecessary mouse clicks while using part replacement tool  

 Issue related to removal of "PrcrbRgd" Load collector card 

 

PamCrash Interface 

Resolved issue: 

 The direction value for CONLO Load changes during import    

 

RADIOSS Interface 

Resolved issue: 

 Rigids created using set option are getting corrupted if they are moved from one collector to 

another 

 

HyperForm  

Resolved issues: 

 
Incremental – LSDYNA 

 Export of duplicate sets for drawbead contact is fixed 

 Missing associativity of trimming direction with trim curve is fixed 



 

HyperWorks Desktop 

12.0.115 Release Notes 
 

Introduction 

HyperWorks HW12.0.115-HWDesktop contains enhancements and bug fixes for HyperMesh, 

HyperView, HyperGraph, HyperCrash and MotionView. The details are documented below.  

Note:  HW12.0.115-HWDesktop is a cumulative release.  It should be installed on top of HW 

12.0.110, and it includes HW12.0.113-HWDesktop. 

 

HyperMesh  

 

New Features 

Assembly browser 

 Performance has improved during the save PLMXML process for large BOMs. 

 

CAD 

 Support for UG NX 9.0 (native reader) 

 UG NX 9.0 now requires the license server to be defined using the SPLM_LICENSE_SERVER 

environment variable, while older NX versions still require the UGS_LICENSE_SERVER environment 
variable. 

 Users can now identify specific parts to include/exclude during JT import using the 

@FilterByJTOpenParts option in the jt_reader.ini file 

 

Connectors 

 New realization is supported and has been updated to the existing configs:    

 RBE3 spider/wagonwheel bolt realization 
 

 

 

Resolved Issues 

 

API 

 Fixed performance issues with hm_getentityvalue command 

 *graphuserwindow_byXYZandR behavior has been corrected 
 
 

Assembly browser 

 Resolved issue where thickness updates to property cards were not reflected in the 

Assembly browser 

 When importing multiple representations pointing to the same material MID, multiple 

renumbered materials are no longer created 

 

 Fixed several save PLMXML issues 

 



 

CAD 

 Addressed a few crashes and instances of incorrect data for JT import 

 

Meshing 

 Fixed issue with component hole detection where certain holes were not properly found 

 Resolved several issues with MPC generation and hole patching for acoustic cavity meshing 

 Resolved issue related to midsurface mesh application error while loading parameter and 

criteria file on Linux platform 

 Resolved issue related to feature edges not deleted after midsurface mesh run 

 Resolved segmentation error related to using abort button in Quality Index panel in an empty 

session 

 

Graphics 

 Resolved a node display issue 

 Resolved a selection issue related to elements in a set that caused a session to hang 
 

Connectors 

 Hilock CBUSH stiffness values rectified in some cases 

 Resolved application error while changing the elem filter options in FEAbsorb adhesive 

 Resolved issue with connector lines export 

 Resolved issue with Penta MIG connector realization with the correct orientation 

 Resolved bolt realization failure issue for a tube section  

 Resolved issue related to Hilock PBUSH property creation 
 

Collaboration Tools 

 Fixed the issue where files with German characters were not added correctly during the Add 

Folders and Files process. 

 Resolved the issue with remote libraries where pre-defined workspaces were not visible. 

 Resolved the issue where the application moved to the background each time new content was 

published. 

 

HyperView 

 

New Features and Enhancements 

 A new option for tracking systems to align with global coordinate system is provided to 

transform the outputs back to global directions. This functionality is useful in obtaining 

intrusion outputs in the global orientation while removing the rigid body motion. 

Displacement-based contour and vector plots, as well as all location based measures like 

position, relative displacement, and distance between are affected when the Use tracking 

option is selected.  

 

 Deformed shape of the model can be exported taking into effect the active tracking system. 

This helps evaluate clearances and part interactions due to deformation in packaging studies. 

The deformed shape resembles exactly as seen in the graphics window with tracking. Align 

with global option on the tracking system influences in which system the coordinates are 

output.  

 Query output of nodal positions is supported when tracking system is active. Align with global 

option on the tracking system influences in which system the coordinates are output. 



 

 

Resolved Issues 

 Recent version of NVIDIA drivers caused an error message “error C6022: No input primitive 

type” and failed to load Accelerated Graphics on startup. This issue is resolved.  

 Drawing code has been updated so that FLC/FLD plots appear properly on machines with ATI 

graphics cards. 

 

HyperGraph 

 

Resolved Issues 

 Axis locked using Fit Range on the Axis panel now keeps their min/max values during curve 

import with the Build Plots panel even when Advanced Options are enabled without Fit Range 

checked 

 Airbag results from LS-Dyna binout files defined with *DEFINE_CPM_CHAMBER are now 

supported by the HyperGraph binout reader 

 Overlaying reports multiple times on Linux sometimes crashed HyperGraph. This issue is fixed.  

 No axis is lost when loading session files containing curves which refer to ASCII result files in 

table format which contain strings like e1, e2, e3 ... in the header line. 

 For some result files, the scaling and offset of curves didn't worked as expected; for example, 

scaling with -1 was ignored or offset values where multiplied by 2. This issue is fixed. 

 Axis labels are no longer suppressed using Tcl based customizing solutions on locked 

computers. 

 Using unmatched Templex references in notes won't crash HyperGraph on Linux.  

 Auto fit plots which contain datum lines in the middle of an axis won't add empty space at the 

end of the curves. 

 Reading curves which contain units not supported by HyperGraph with the Units scaling 

feature turned on triggered error messages and prevented further math operations. This issue 

is fixed. 

 

MotionView 

 

Resolved Issues 

 Curve Panel  

 Fixed the issue where clicking on Show curve with Interpolation fails with errors when the 

HyperWorks session contains a HyperGraph client. 
 
 
 

OptiStruct Interface 

New Features and Enhancements 

 Auto Contact option 

 New option in OptiStruct Auto Contact user interface: Consolidate contact patches between contact 

pairs.  This option consolidates any separate contact patch areas that participate in contacts 

between the same two components, so that the final number of master-slave pairs in the model can 
be reduced. Activating this option may greatly increase contact search performance for some 
models. 

 
 



 

Resolved Issues 

 Material MID4 and Z1/Z2 options can now be defined simultaneously, while ZOFFS and MID4 

are now mutually exclusive. 

 Fixed an issue with Z0 option inside PCOMP, PCOMPG, PCOMPP not exporting when opening a 

pre-12.0.110 HyperMesh database file and exporting the model immediately without 

performing card edit. 

 Issue when importing CBAR elements referencing a system that references another system 

which is missing from the model has been corrected. 

 Ansys > OptiStruct solver conversion resolved issues: 

 Issue with CP_STRUCT entities failing to convert has been fixed. 

 Error message when converting some models with loadstep definitions has been fixed. 

 Fixed issue with converting temperature dependent materials with wrong temperature order 

from Abaqus to OptiStruct, producing solver error. 

 Fixed an issue in the Optimization Response panel where MASS and VOLUME response types 

were filtering out PSHEAR properties from selection. 

 Fixed an issue where Modal Frequency Response subcase created in the Loadstep panel was 

showing the wrong label in the Loadstep browser. 
 
 

Nastran Interface 

 

Resolved Issues 

 Material MID4 and Z1/Z2 options are now allowed to be defined simultaneously, while ZOFFS 

and MID4 are now mutually exclusive. 

 Issue when importing CBAR elements referencing a system that references another system 

which is missing from the model has been corrected. 

 Issue with HyperView reader crashing when importing a Nastran model containing include files 

containing only BCONTACT cards has been fixed. 

 

Abaqus Interface 

 

New Features and Enhancements 

 *TIME POINTS keyword is supported as a group entity. This can also be referred in the 

*OUTPUT keyword. 

 

Resolved Issues 

 If an element ID is greater than 9, then *surface was not exporting proper data into input 

deck. The element ID limit is increased to 16. 

 The name provided for *Distribution Table is retained during import and export. 

 Apart from Length/Ratio/Drape, any unsupported *Distribution entity is moved to an 

unsupported card. 

 

Ansys Interface 

Resolved issues: 

 HyperMesh: Pretension bolt utility was not working for BEAM elements created with direction 

node option. This issue is fixed. 



 

 HyperMesh: Issue with export where an extra load constraint was exported is fixed.  

 HyperView: Results for composite models with layer definition by sections were swapped 

between layers. This is fixed now. 

 HyperView: Fixed the issue with tensor results missing for solid elements in the models that 

have composite shell elements.  

 

Ls-Dyna Interface 

New Features and Enhancements 

 Import reader detects unsupported lines in the deck for control cards and gives warning 

message upon import. 

 In the Model Checker, review of Untied nodes in Contact Tied is now available. 

 

Resolved Issues 

 Support of new keyword *MAT_COHESIVE_MIXED_MODE_ELASTOPLASTIC_RATE_TITLE 

 Support of new keyword *DEFINE_VECTOR_NODES 

 Values of SIG22, SIG33 and SIG23 is read irrespective of the value of LOCAL for *Initial 

_stress_beam 

 If *INCLUDE is followed by *INCLUDE_TRANSFORMATION everything works as intended.  

However, if the order is changed so that *INCLUDE_TRANSFORMATION is followed by 

*INCLUDE, only the transformed model was imported.  This issue has been fixed.  

 Proper import of *Mat_Add_Erosion with optional card containing LCFLD now occurs.  

 Proper import of Primer cards *MECHANISM_START and *MECHANISM_END and export after 

*END upon export now occurs. 

 In the Model Checker, checks are run twice if the user switches between error and entity view.  

This has been fixed. 

 In select cases when using the Find Attached (Tied) macro, the issue of finding elements till 

end of the component has been fixed. 

 Sometimes the mass value disappeared after quality indexing. This has been fixed. 

 Exporting Ls-Dyna Key-File sometimes exports Mass Element Values as 0.0. This has been 

fixed. 

 Incorrect GUI representation when converting PCOMPG to *Part_Composite has been fixed.  

 Connectors update was missing in most cases when converting OptiStruct to LS-DYNA 

conversion Tool. This has been fixed.  

 Resolved status update issue between Error view and HM Entity view of Model Checker.  

 

Pam-Crash Interface 

 

Resolved Issues 

 Issue related to Material ID higher than "7" digits is not supported in HyperMesh for one of the 

options has been fixed 

 

BasicFEA 

 

Resolved Issues 

 Resolved units saving issue with material data. 



 

NVH 

 

Resolved Issues 

 Resolved issue where the coarse display creation functionality in the batch prepare module 

feature always renumbered entities of the original model 

 Resolved issue where switching from one module to another frequently within the edit module 

feature caused HyperMesh to freeze up 

 

HyperCrash 
 

Resolved Issues 

 Resolved issue where HyperCrash was resetting the master node location regardless of the 

value of the Icog flag 

 Resolved issue where the current MCO was ignored during the entity creation process if the 

element type used in that MCO was similar to the one used in the default MCO 

 
 



 

HyperWorks Desktop 

12.0.113 Release Notes 
 

Introduction 

HyperWorks HW12.0.113-HWDesktop contains enhancements to HyperMesh and HyperCrash. The 

details are documented below.  

Note:  HW12.0.113-HWDesktop includes HW12.0.112-HWDesktop and HW12.0.112-RENUMBER-

HWDesktop. 

 

HyperMesh  

 

New Features and Enhancements 

 

Connectors 

 Bolt L1/L2 Graphical Cylinder with Vector 

 Cylinder preview  

 Vector preview 

 Temporarily or permanent display 

 Transparency changeable 

 Export Dynamic Bolt Vector Option 

 For MCF export (version A) the dynamically identified bolt connector vector will be exported by 

default now 

 Link Groups now visible in Connector browser 

 Properties are now available as connector links 

 A special property view has been added to the connector browser 

 Link groups are shown in the connector browser 

 Details are given in message boxes 

 All find and display mechanisms are supported for properties and groups as well 

 Property link groups are exported in MCF 

 New Radioss and Dyna Connector Realizations 

 Automatic exclusion of of special nodes during rigid bolt realization (HyperCrash logic) 

 Hexa spot with contact and material (law 59) definition 

 Seamweld and adhesive connector types supported via MCF 

 Connector realization type specified in new mapping file for automatic realization 

 Users’ connector type selection limited to only thos available in mapping file 

 MCF Properties available as columns in Connector browser 

 Enhanced MCF Support 

 Import and Export of MCF supported  

 Property links supported 

 Ability to move connectors between MCF files 

 

 Connector Auto-realization 
1. Connectors realized automatically upon import 



 

2. Log file generated providing realization details 

 
 

 

Module Enhancements 

Current Module Support 

 Set current module similar to current component behavior, from  

 Assembly Browser thru a context menu 

 From HM status bar 

 Current Module & current component automatically kept in sync 

 Module-Entity Organization: Provides the ability to organize components, materials or properties 

from one module to another 

 Module Show Contents: View the components, materials, and properties owned by the selected 

Module 

 
 

 

Assembly browser Enhancements 

Batch mesh integration UI enhancements 

 Individual modules can now be meshed to specific mesh criteria and parameters; previously, 

all files had to be meshed to the same criteria 

 Mesh criteria and parameter files can be mapped to values in the Assembly browser for 

automatic selection 

Assembly browser filtering 

 The Assembly browser will now provide advanced filtering tools to filter BOMs based on their 

properties, existence of a representation, etc. 

 
 

 

Ls-Dyna Interface:  

 A new part replacement feature is available in this release that is faster, more powerful and 

accurate compared to previous versions of the functionality.  This is available for Ls-Dyna and 

Engineering solutions Ls-Dyna user profiles only. 

 Find attached (Tied):  A new feature for find attached based on Ls-Dyna contacts.  The new 

find attached will detect physically connected entities or find attached entities that are 

considered physical connections via their tied contact definitions in Ls-Dyna. 

 
 

 

Resolved Issues 

 When renumbering there are instances of duplicate entity IDs being created. The most 

prevalent is duplicate element IDs.  However, duplicate property IDs can also be created.  

Focusing on the element use case: the duplicate element IDs can be created once a renumber 

operation is complete followed by an operation that creates elements (such as split, or 

duplicate>>translate/rotate, or even mesh). The issue can occur with the following user 

profiles - Abaqus, Permas, Nastran, OptiStruct, Ls-Dyna, RADIOSS and Pamcrash. 

 Duplicate set id’s are created as a result of duplicate>>translate/reflect operations on rigid 

elements. This issue affects the RADIOSS user profile. 
 
 
 

 
 
 
 
 
 

Known Assembly Browser Limitations 

Show contents  

 There is currently no way to visualize the contents of the default master connection file.  This 

leads to the risk that the user will lose connectors if they’re in the default file but not moved to 

an MCF file that is a representation of a module 

Import from Assembly browser 



 

 If an error is encountered during importing of multiple representations, then the import 

process stops rather than continuing from the next representation in the list.  Users can 

continue by selecting the remaining representations and importing again. 

 

HyperForm 

 

Resolved Issues 

 OneStep – RADIOSS 

 While plotting formability either from OneStep browser or FLD Plots panel, mismatch of colors 

corresponding to different zones in Formability contour and FLD plot is fixed. 

 

HyperCrash 

 

General 

 Lock/Freeze feature: Allow locking some entities or filing against modification, delete, 

renumbering into session or into a new session as the lock status is saved into the exported 

deck 

 Save View feature: Freeze displayed screen in the session and outside session 

 Export Selection: New “simplified export selection“ and redesign and fix of classic “export 

selection” 

 Include setting panel: Allow displaying min/max ID and range bounding failure in red and 

some automatic and manual fix to renumber all IDs 

 Modified Include File Marker: End name of include file will include “*” sign, if an entity is 

created, modified, or deleted from generic panel or browser.  Some other ways to modify a 

model need to be plugged too such as: drag and drop, renumber, node move on mesh(…?) 

 
 

 

Safety Tools 

 DUMMY POSITIONER with pre-simulation: Allow to deform intersected part of dummies 

 NEW SEAT DEFORMER by pre-simulation: Allow do deform seat with pre-simulation on 

intersected dummy/seat 

 
 

 

Connectors 

 MCF Enhancements: Key and property tags supported for bolts 

 Part of connection: Part of connection is now maintain during the session with a special icon 

and special behavior. 

 

 

 Connection panel: Changing a material or a property from connection panel is working now 

correctly 

 Realization with existing material or property: Material of property loaded from xml is 

used in realization auto or one-by-one. During replace the property or Material defined as 

“FIXED” into “.mco” file is maintain in the connection involved into replace part 
 
 

 

RADIOSS Profile 

 Transformation Matrix Enhancements: Full support for /TRANSFORM/MATRIX card in 

RADIOSS 



 

 /PARAMETER support: Full support in RADIOSS 12 profile 

 Edit Support Enhancements:  

 New cell support widget to be able to set the support by Id or to create simply on the fly 

 New menu to create and manage all group type : ([FORD] like group by SUBSET ...) 

 Include File Enhancements: Allow the reading of a deck and include in different RADIOSS 

version 

 Include File Management: Range ID of include and lock status are now exported into each 

individual include file 

 Result Initialization Feature: Allow result initialization on a selection of part from Tree or 

Browser 

 LSDYNA to RADIOSS Enhancements: Lots of converter enhancements 

 Modularization: Some important fixes for Modularization project and  some other issues 

 De-Penetration tool Enhancements: Computation with “Igap = 3” 

 Local skew frame Enhancements: Local skew frame have now “View” options and “Mesh 

support” feature 

 
 

 

LS-Dyna Profile 

 New Include File Enhancements: Allow to import only some include of a complete deck by 

selecting the needed include from the main deck 

 New Replace Part by pairing: Allow to select the one by one part pairing in one shot 

 New Entities “Loadcase” fully supported: “Boundary Temperature”, “Database Pwp Flow”, 

“Load Blast”,  “Load Blast Segment” 

 New Entities “Tools” fully supported: ‘Define Cpm…”, “Define filter”, “Interface 

Component”, “ Interface Linking” 

 Part panel Enhancement:  “Part type” column added to display the icon corresponding to 

part type : rigid, initial condition, unresolved, connection… 
 
 

 

Other UI Enhancements 

 New Search by ID option: Nice and advanced feature to search entities by id from generic 

panel 

 Cross reference Enhancements: New “Select in Browser” popup feature 

 Browser open at the file loading: Any new imported deck will now open the browser panel: 

nor in include hierarchy mode (if some include are detected) nor in model hierarchy mode 

 



 

HyperWorks Desktop 

12.0.112 Release Notes 
 

Introduction 

HyperWorks HW12.0.112-HWDesktop contains enhancements and bug fixes to the desktop applications 

HyperMesh, HyperView, HyperGraph, MotionView, and Collaboration Tools. The details are documented 

below.  

Note:  HW12.0.111-HWDesktop is a custom release that is not included in HW12.0.112-HWDesktop. 

 

HyperMesh  

 

New Features and Enhancements 

Nastran Interface: Auto Contact tool 

 The Auto Contact tool for Nastran allows you to quickly and easily create one or many contact 

interfaces at once between several parts of your model. The Auto Contact Browser organizes 

all interfaces found by the Auto Contact search, where you can review and modify them before 

accepting any changes. 

 This tool is accessible in HyperMesh 12.0.112 via any of the following locations: 

 Tools menu > Auto-Contact 

 BCs menu > Create > Auto-Contact 

 Utility Menu > Nastran1 > Analysis Setup: Auto-Contact 

 Nastran Interface: Solver Card Support Updates 

 CHBDYP: New Spring and Mass element types. 

 PHBDY: New Property. 

 CONVM: New extension card inside CHBDYP. 

 PCONVM: New Property. 

Nastran Interface 

 Added comment support for  nodes and elements 

 

Abaqus to OptiStruct Conversion 

 CONN3D elements to CBUSH/PBUSH. 

 Distributed Coupling surfaces to RBE3. 

 Offset definitions for composites using SNEG/SPOS keywords. 

 Orthotropic material to MAT8. 

 

 

OptiStruct Interface: Solver Card Support Updates 

 PCOMP, PCOMPG, PCOMPP: TOP/BOTTOM options for Z0. 

 DSIZE, DCOMP: New option for ply drop-off manufacturing constraints (PLYDRP). 
 

Abaqus Interface 

 *Fail stress keyword is supported for Abaqus Material. 



 

 

User Interface 

 Bolding of the browser tab text has been added to provide feedback as to which is the active 

tab.  

 Added a partition in the browser to indicate a separation in the controls between the global 

display controls and the action modes (selector, show/hide, isolate). 

 Added toolbar tool tip help when mousing over the toolbar handle.  

 Reorganized the Mesh>Edit pull-down menu. 
 

Connectors 

 A new realization type for the Dyna user profile has been introduced, the  ACM (shell gap 

+ coating). 

 This realization creates a round hexa pattern between shell flanges by creating congruent 

meshes. 

 The user can chose between different hexa patterns and define the diameter. Additionally 

the creation of a washer layer can be requested. 

 For each hexa pattern a keyword *DEFINE_HEX_SPOTWELD_ASSEMBLY_<# of hexas> is 

created. 
 

Shell to Solid conversion 

A third method of creating Solid composite layers from shell composite definition for Abaqus is 

supported. In this method users can group ply layers using a dummy plies and the software will create 

a single solid for the group of plies separated by the dummy layers. With the addition of this method, 

users could create single solid for all the plies or a single solid to represent each ply or multiple solids 

for grouping of plies. 

 

Line Loads 

Ability to assign total or distributed loads to nodes on a geometry line or a list of nodes is added, and 

then can automatically calculate the nodal loads. 

 

Improved Performance 

Improved performance of HM FBD tools for OP2 results and added support for XDB results. 

 
 

 

Resolved Issues 

 Segmentation error with OSSmooth.  

 Segmentation error when splitting surfaces. 

 Segmentation error when tetrameshing. 

 Long selection times when picking nodes by window on Linux. 

 Display of normals not working correctly in the Interfaces panel 

 FE overwrite behavior issue when importing properties in OptiStruct and Ls-Dyna solver 

interfaces. 

 Resolved several file specific issues related to the JT, CREO2.0 CAD readers 

 CFD Meshing 

 Selecting boundaries with quad elements as “with BL float” fails to generate mesh 

 Using the selection “with BL float” and rejecting the tetramesh generates free edges 

 Using remesh including a refinement zone, the resulting remeshed region doesn’t follow the shape 

of the refinement zones 

 Browser 

 FE/Geometry display/filter mode wasn’t working correctly in certain cases. 



 

 “Show” operation was returning the plots. Show behavior is now consistent with Hide and Isolate. 

 Ansys Interface 

 Issue with Constraint Equations where equations with thermal labels (DOF) were not handled by 

HyperMesh in earlier versions has been fixed now. 

 Issue with export of load steps where loads applied on same node in same direction were not 

combined is now fixed. 

 OptiStruct to ANSYS conversion 

 Defect where material properties to the components were not getting assigned after conversion has 

been fixed. 

 Abaqus to OptiStruct Conversion 

 Conversion of Abaqus *MPC PIN to OptiStruct RBE2 without DOF values issue has been corrected. 

 OptiStruct Interface 

 HyperMesh error message due to renumbering of DTABLE entries has been fixed. 

 Abaqus Interface 

 Defect while exporting an input deck with a MPC Beam converted into a Kinematic or Distribution 

coupling. 

 LSDYNA interface 

 Issue with conversion of spotwelds from Nastran to LSDYNA has been fixed 

 Issue with reading parameterized *ALE_REFERENCE_GEOMETRY_BIRTH_RDT keyword has been 

fixed 

 Support of -2 and -1 options for ELFORM in *SECTION_SOLID 

 False error message during import of *CONSTRAINED_EXTRA_NODES_NODE/SET has been 

removed. 

 

 

 

Known Issues 

 A crash can be encountered if either Catia, ProE, ACIS, STEP, SolidWorks, or non-native UG 

reader is invoked at least once, and, within the same session, the native Parasolid reader is 

then invoked - the crash occurs during this secondary import operation.  If the order of these 

two operations is reverted, the crash does not occur. The workaround is to import the 

parasolid file with parasolid reader within a brand new HyperMesh session. 

 

HyperView 

 

Abaqus interface 

 The Abaqus 6.13 reader has been added for Windows 64bit and Linux 64bit. HyperWorks 

12.0.112 also supports these versions: 6.10, 6.10-EF, 6.11, 6.12. 

 
 

 

LSDYNA interface 

 FEMZIP reader upgraded to FEMZIP 6.05 libraries to fix issues reported in FEMZIP 6.0 libraries. 

 

 

Resolved issues 

 Math operations on 1D element results enabled for all solvers. 

 Magnitude for Incremental Distance is restored to a scalar difference of change in distance as 

was the case in v12.0 and earlier. 

 Ansys Interface 

 Issue with results for the solution with large number of simulationswhere vonMises results for the 

last simulation were not displayed has been fixed now. 



 

 AcuSolve Interface 

 Selecting “Velocity_magnitude” as a result type for contouring will use volume strain rate for 

contouring. 
 

 

HyperGraph 

Resolved issues 

 LSDYNA interface: Issue with reading rwforc data in binout file has been resolved. 

 

MotionView 

Resolved issues 

 Issue of longer times on opening models containing assemblies with shared definition is 

resolved. 

 Expression builder reports “Error Evaluating” while accessing data members within a table. 

This issue is fixed. 

 An application error is selecting dataset options after repeated clearing of MotionView session 

is fixed. 

 Curve Panel: Clicking on “Show curve with Interpolation fails with errors when HW session 

contains a HyperGraph client. This issue is fixed. 

 

HyperWorks Desktop Collaboration Tools 

Resolved Issues 

 Issue where contents from a read only library were not visible in the Workspace View has 

been fixed. 

 The Collaboration Tools license is no longer being checked out when users are just performing 

save, save as, or export operations. 

 The issue where users were unable to log in to a remote (Enterprise) library on a Linux host 

has been resolved.    

 Appropriate context menus are now displayed for contents retrieved from remote  

(Enterprise) libraries.  Previously, the context menus were displayed as if all contents were 

General Files and not the actual content type (e.g. Solver Deck, HyperMesh Model, etc.). 

 

 The issue with the Query Editor where users were unable to query in specific folders or 

categories along with other metadata-based search criteria has been resolved. 

 

NVH 

Resolved Issues 

 Issues related to assembly XML file import using ‘Child’ and ‘Replace’ options 

 Issue related to multiple AutoTPA requests in the General Frequency Response Process 

Manager 

 Issues related to AutoTPA and Traditional TPA elements set definition in the General Frequency 

Response Process Manager  

 Issue related to incorrect reference to module state MPC in the General Frequency Response 

Process Manager 

 Issues related to multiple AutoTPA results (control volumes) support in the Transfer Path 

Analysis Utility 


